 
   
    
     
      
    
 
     
      
       
       
     
 
    
 
   
 
   
     
     
      
       
        
        Unsupported version Error while generating header and footer for the PDF
 
        
          hi 
 I want to genrate header and footer for the PDF file however on the call of the EndPage class i got a Unsupported Version Error Unsupported major minor Version Error and Class loader Define class
 What has gone wrong ?. 
        
 

         
         Can you provide more information about what you were trying to do? In particular, what does your code like like?

Also, can you include the stack trace, and the complete error message?
 
         
 
          more
 

          
          Similar Messages
 
          
 
           	 
		     Error occured while genrating header and footer for the PDF
 
			 Hi All ,
 I am getting a following error whenever i try to excecute the code to print header and footer while genrating a PDF what could be the reason.Any help would be greately appreciated. following is the error stack trace: i am excecuting it in the command prompt an using jdk1.5.0.1
 C:\Program Files\Sun\Creator2_1\java\Test>java EndPage
 Exception in thread "main" java.lang.UnsupportedClassVersionError: EndPage (Unsu
 pported major.minor version 49.0)
 at java.lang.ClassLoader.defineClass0(Native Method)
 at java.lang.ClassLoader.defineClass(ClassLoader.java:502)
 at java.security.SecureClassLoader.defineClass(SecureClassLoader.java:12
 3)
 at java.net.URLClassLoader.defineClass(URLClassLoader.java:250)
 at java.net.URLClassLoader.access$100(URLClassLoader.java:54)
 at java.net.URLClassLoader$1.run(URLClassLoader.java:193)
 at java.security.AccessController.doPrivileged(Native Method)
 at java.net.URLClassLoader.findClass(URLClassLoader.java:186)
 at java.lang.ClassLoader.loadClass(ClassLoader.java:299)
 at sun.misc.Launcher$AppClassLoader.loadClass(Launcher.java:265)
 at java.lang.ClassLoader.loadClass(ClassLoader.java:255)
 at java.lang.ClassLoader.loadClassInternal(ClassLoader.java:315)
 
			 Looks like the EndPage class was compiled with a later version of Java (49.0 == Java 1.5) and you are trying to run it with older version of java.exe. Type

java -version

to verify.

Also this forum is for Sun Java Studio Creator related questions. Please ask such questions on java tools forum.

Sandip
 
		   

 
           	 
		     How to add header and footer image in pdf
 
			 Hi,
 I want to add image in header and footer for the pdf generation.
 how I can add this? Following my xsl
 ?xml version="1.0" encoding="UTF-8"?>
 <xsl:stylesheet version="1.0" xmlns:xsl="http://www.w3.org/1999/XSL/Transform"
 xmlns:fo="http://www.w3.org/1999/XSL/Format"
 xmlns:fn="http://www.w3.org/2005/xpath-functions">
 <xsl:output method="xml" indent="yes" encoding="utf-8" omit-xml-declaration = "yes" />
 <xsl:template match="/">
 <fo:root>
 <fo:layout-master-set>
 <fo:simple-page-master master-name="my-page">
 <fo:region-body margin="1in"/>
 </fo:simple-page-master>
 </fo:layout-master-set>
 <fo:page-sequence master-reference="my-page">
 <fo:flow flow-name="xsl-region-body">
 <fo:block >
 <xsl:apply-templates mode="dump" select="/session/entity/instance/attribute"/>
 </fo:block>
 </fo:flow>
 </fo:page-sequence>
 </fo:root>
 </xsl:template>
 <xsl:template match="*" mode="dump" priority="100">
 <fo:block >
                <fo:block margin-left="1cm">
                     <xsl:for-each select="@question-text">
                     <xsl:value-of select="."/>=
                     </xsl:for-each>
                     <xsl:if test="string-length(normalize-space(text())) > 0">
                     <xsl:value-of select="text()"/>
                     </xsl:if>
                </fo:block>
 <xsl:apply-templates mode="dump" select="*"/>
 </fo:block>
 </xsl:template>
 </xsl:stylesheet>
 Edited by: 848231 on Apr 6, 2011 1:42 AM
 
			 Hi,

Here is one way of putting an image in the header:

<fo:layout-master-set>

    <fo:simple-page-master master-name="my-page">     

      <fo:region-body margin="1in"/>

      <fo:region-before extent="1in" background-color="silver" />

    </fo:simple-page-master>

  </fo:layout-master-set>

  <fo:page-sequence master-reference="my-page">

     <fo:static-content flow-name="xsl-region-before">

         <fo:block height="150px" width="1024px" background-color="white" >

             <fo:external-graphic src="http://localhost:9000/web-determinations9000/images/Header.jpg">

             </fo:external-graphic>

        </fo:block>

    </fo:static-content>

    <fo:flow flow-name="xsl-region-body">

    </fo:flow>

  </fo:page-sequence>One good XSL:FO refernce: http://www.learn-xsl-fo-tutorial.com

Hope this helps.

Thanks,

Aakarsh

Edited by: aakarsh on Apr 6, 2011 6:40 AM
 
		   

 
           	 
		     Customizing header and footer in the printed documentation
 
			 Hi,
 I'm using a trial version of RoboHelp 2007 and Word 2003.
 I have two question about customizing the header and footer
 of the printed documentation.
 In the printed documentation the footer repeat at the bottom
 of each page and contain page numbers, which appear left-justified
 on even-numbered pages and right-justified on odd-numbered pages.
 How can I customize the footer, that pages numbers appear
 always right-justified?
 In the printed documentation the header repeat at the top of
 each page and are blank on the first page of sections. The name of
 the manual appears on even-numbered pages, left-justified. The name
 of the root chapter appears on odd-numbered pages, right-justified.
 How can I customize the header, that 
 on every page the name of the root chapter and the name oft
 the manual appears? Furhermore I want to include a picture in the
 header. How can I realise this?
 
			 You can't from RH. See the article on my site.

Images in the header are tricky. If you use the setting that

I think enables that, you will also get the images in the TOC. Try

putting a two cell table and putting the heading in one and the

image in another.
 
		   

 
           	 
		     How do i add images in the header and footer to a PDF using iText
 
			 Hi ,
 I want to add images to the header and footer of every page while i am genrating a pdf i have created a separate class called EndPage which i am instanceiating its default constructor in another class 's button action method.
 The above code genrates a PDF for me however it genrates a file with file size zero bytes and does not open it following is my sample code
 //**********Any Help would be appreciated 
 Thank You
 public class My_Class 
 public String pdf_action() 
 EndPage ep=new EndPage();
 return null;
 }//My_class Ends
 class EndPage extends PdfPageEventHelper 
 * Demonstrates the use of PageEvents.
 * @param args no arguments needed
 public EndPage()
 try {
 com.lowagie.text.Document document = new Document(PageSize.A4, 50, 50, 70, 70);
 PdfWriter writer = PdfWriter.getInstance(document, new FileOutputStream("D://proposals/endpage.pdf"));
 writer.setPageEvent(new EndPage());
 document.open();
 String text = "Lots of text. ";
 for (int k = 0; k < 10; ++k)
 text += text;
 document.add(new Paragraph(text));
 document.close();
 catch (Exception de) {
 de.printStackTrace();
 public void onEndPage(PdfWriter writer, Document document) {
 try {
 Rectangle page = document.getPageSize();
 PdfPTable head = new PdfPTable(3);
 for (int k = 1; k <= 6; ++k)
 head.addCell("head " + k);
 head.setTotalWidth(page.width() - document.leftMargin() - document.rightMargin());
 head.writeSelectedRows(0, -1, document.leftMargin(), page.height() - document.topMargin() + head.getTotalHeight(),
 writer.getDirectContent());
 PdfPTable foot = new PdfPTable(3);
 for (int k = 1; k <= 6; ++k)
 foot.addCell("foot " + k);
 foot.setTotalWidth(page.width() - document.leftMargin() - document.rightMargin());
 foot.writeSelectedRows(0, -1, document.leftMargin(), document.bottomMargin(),
 writer.getDirectContent());
 catch (Exception e) {
 throw new ExceptionConverter(e);
 }
 
			 Hi,

Thanks for the quick response.

The problem is that when I keep the logo as a watermark, the pdf is not adjusting itself to include the logo as header.

But if I add a header text via Tools -> Headers and Footers, the pdf is adjusting itself so that the header text is at the beginning , not overlapping with the contents of pdf. 

But while using logo as watermark, some times overlapping of the pdf contents and logo is happening.

Is there any way to add a logo in the Header and Footer via the option in Tools -> Headers and Footers

Thanks,

Vidhya
 
		   

 
           	 
		     How to change the header and footer in the Section Breaks Next Page using OpenXML?
 
			 I have a word document file in which I added a Section Break of Next Page, now I want to change the header and footer of that page.
 Scenario of example, I have a doc file which has four pages with headers and footers and added fifth page in the section break next page, I want to change the header and footer of the fifth page only. This is achievable manually by deselecting the Link to Previous
  button in the Word Application but I don't know how to change it using XML?
 My code that adds the new page in the section breaks is:
 class Program
 		static void Main(string[] args)
 			string path = @"C:\Riyaz\sample.docx";
 			string strtxt = "Hello This is done by programmatically";      
 		   OpenAndAddTextToWordDocument(path,strtxt);
 		public static void OpenAndAddTextToWordDocument(string filepath, string txt)
 			using (DocX document = DocX.Load(@"C:\Riyaz\sample.docx"))
 				document.InsertSectionPageBreak();
 				Paragraph p1 = document.InsertParagraph();
 				p1.Append("This is new section");
 				document.Save();
 Please help.
 
			 Here is the sample for your reference:

using System;

using System.Collections.Generic;

using System.Linq;

using System.Text;

using DocumentFormat.OpenXml;

using DocumentFormat.OpenXml.Packaging;

using DocumentFormat.OpenXml.Wordprocessing;

namespace WordAddNewFooterHeader

    class Program

        static void Main(string[] args)

            string path = @"E:\Document\TestHeaderandfooter-Copy.docx";

            string strtxt = "OpenXML SDK";

            OpenAndAddTextToWordDocument(path, strtxt);

        public static void OpenAndAddTextToWordDocument(string filepath, string txt)

            // Open a WordprocessingDocument for editing using the filepath.

            WordprocessingDocument wordprocessingDocument = WordprocessingDocument.Open(filepath, true);

            MainDocumentPart part = wordprocessingDocument.MainDocumentPart;

            Body body = part.Document.Body;

            //create a new footer Id=rIdf2

            FooterPart footerPart2 = part.AddNewPart<FooterPart>("rIdf2");

            GenerateFooterPartContent(footerPart2);

            //create a new header Id=rIdh2

            HeaderPart headerPart2 = part.AddNewPart<HeaderPart>("rIdh2");

            GenerateHeaderPartContent(headerPart2);

            //replace the attribute of SectionProperties to add new footer and header

            SectionProperties lxml = body.GetFirstChild<SectionProperties>();

            lxml.GetFirstChild<HeaderReference>().Remove();

            lxml.GetFirstChild<FooterReference>().Remove();

            HeaderReference headerReference1 = new HeaderReference() { Type = HeaderFooterValues.Default, Id = "rIdh2" };

            FooterReference footerReference1 = new FooterReference() { Type = HeaderFooterValues.Default, Id = "rIdf2" };

            lxml.Append(headerReference1);

            lxml.Append(footerReference1);

            //add the correlation of last Paragraph

            OpenXmlElement oxl = body.ChildElements.GetItem(body.ChildElements.Count - 2);

            ParagraphProperties paragraphProperties1 = new ParagraphProperties();

            SectionProperties sectionProperties1 = new SectionProperties() { RsidR = oxl.GetAttribute("rsidR", oxl.NamespaceUri).Value };

            HeaderReference headerReference2 = new HeaderReference() { Type = HeaderFooterValues.Default, Id = part.GetIdOfPart(part.HeaderParts.FirstOrDefault()) };

            FooterReference footerReference2 = new FooterReference() { Type = HeaderFooterValues.Default, Id = part.GetIdOfPart(part.FooterParts.FirstOrDefault()) };

            PageSize pageSize1 = new PageSize() { Width = (UInt32Value)12240U, Height = (UInt32Value)15840U };

            PageMargin pageMargin1 = new PageMargin() { Top = 1440, Right = (UInt32Value)1440U, Bottom = 1440, Left = (UInt32Value)1440U, Header = (UInt32Value)720U, Footer = (UInt32Value)720U, Gutter = (UInt32Value)0U };

            Columns columns1 = new Columns() { Space = "720" };

            DocGrid docGrid1 = new DocGrid() { LinePitch = 360 };

            sectionProperties1.Append(headerReference2);

            sectionProperties1.Append(footerReference2);

            sectionProperties1.Append(pageSize1);

            sectionProperties1.Append(pageMargin1);

            sectionProperties1.Append(columns1);

            sectionProperties1.Append(docGrid1);

            paragraphProperties1.Append(sectionProperties1);

            oxl.InsertAt<ParagraphProperties>(paragraphProperties1, 0);

            body.InsertBefore<Paragraph>(GenerateParagraph(txt, oxl.GetAttribute("rsidRDefault", oxl.NamespaceUri).Value), body.GetFirstChild<SectionProperties>());

            part.Document.Save();

            wordprocessingDocument.Close();

        //Generate new Paragraph

        public static Paragraph GenerateParagraph(string text, string rsidR)

            Paragraph paragraph1 = new Paragraph() { RsidParagraphAddition = rsidR };

            ParagraphProperties paragraphProperties1 = new ParagraphProperties();

            Tabs tabs1 = new Tabs();

            TabStop tabStop1 = new TabStop() { Val = TabStopValues.Left, Position = 5583 };

            tabs1.Append(tabStop1);

            paragraphProperties1.Append(tabs1);

            Run run1 = new Run();

            Text text1 = new Text();

            text1.Text = text;

            run1.Append(text1);

            Run run2 = new Run();

            TabChar tabChar1 = new TabChar();

            run2.Append(tabChar1);

            paragraph1.Append(paragraphProperties1);

            paragraph1.Append(run1);

            paragraph1.Append(run2);

            return paragraph1;

        static void GenerateHeaderPartContent(HeaderPart hpart)

            Header header1 = new Header();

            Paragraph paragraph1 = new Paragraph();

            ParagraphProperties paragraphProperties1 = new ParagraphProperties();

            ParagraphStyleId paragraphStyleId1 = new ParagraphStyleId() { Val = "Header" };

            paragraphProperties1.Append(paragraphStyleId1);

            Run run1 = new Run();

            Text text1 = new Text();

            text1.Text = "";

            run1.Append(text1);

            paragraph1.Append(paragraphProperties1);

            paragraph1.Append(run1);

            header1.Append(paragraph1);

            hpart.Header = header1;

        static void GenerateFooterPartContent(FooterPart fpart)

            Footer footer1 = new Footer();

            Paragraph paragraph1 = new Paragraph();

            ParagraphProperties paragraphProperties1 = new ParagraphProperties();

            ParagraphStyleId paragraphStyleId1 = new ParagraphStyleId() { Val = "Footer" };

            paragraphProperties1.Append(paragraphStyleId1);

            Run run1 = new Run();

            Text text1 = new Text();

            text1.Text = "";

            run1.Append(text1);

            paragraph1.Append(paragraphProperties1);

            paragraph1.Append(run1);

            footer1.Append(paragraph1);

            fpart.Footer = footer1;

We are trying to better understand customer views on social support experience, so your participation in this interview project would be greatly appreciated if you have time. Thanks for helping make community forums a great place.

Click 

HERE to participate the survey.
 
		   

 
           	 
		     Avoid printing Header and Footer in the last page
 
			 Hi,
 Could anyone please let me know how to avoid print the header and footer in the last page? 
 Note: I'm printing RTF template for publishing the output.
 Looking forward for your valuable inputs/suggestions.
 Thanks in advance,
 Regards,
 Muru
 
			 Hai,

My report got FROM PO & TO PO parameters and i need to print footer only in first page of each PO. Tried with section but now i am getting first page of all PO contionious and then all lines together.

Please call me or sent replies to [email protected]
 
		   

 
           	 
		     How to generate Header and Trailer for a file
 
			 Hi Guru
 How can we generate header and Trailer for a file
 EX:
 i want to generate header with date and trailer with record count from table.
 Sample file :
 20120120
 fwsfs
 adfwsfd
 adff
 afsadf
 afdwsg
 adgsg
 adgsgg
 asgdsag
 sdgasgdaf
 sdfsagfadf
 10
 
			 Hi ,

1.Create an interface to load data from oracle to file and set generate header as false option in IKM .

2.Create variable get_current_date of alphanumeric datatype and implement logic SELECT to_Char(SYSDATE,'yyyymmdd') FROM DUAL under refreshing tab

3.Create variable get_record_count of numeric datatype and implement logic SELECT '<%=odiRef.getPrevStepLog("INSERT_COUNT")%>' FROM DUAL under refreshing tab

4.Create a package

Drag the get_current_date variable ,

Drag odioutfile and paste the below logic OdiOutFile "-FILE=D:\ODI_TEST\emp.txt" "-CHARSET_ENCODING=ISO8859_1" "-XROW_SEP=0D0A" #GET_current_date in command tab

Drag the interface

Drag another variable get_Record_count 

Drag the odioutfile and paste the below logic OdiOutFile "-FILE=D:\ODI_TEST\emp.txt" -APPEND "-CHARSET_ENCODING=ISO8859_1" "-XROW_SEP=0D0A"

#GET_RECORD_COUNT in command tab

Link all these in sequence,save and run the package.

OR Modify the IKM SQL to File Append to achieve same functionality. 

Thanks,

Anuradha
 
		   

 
           	 
		     Header and Footer for PDF with images using itext.jar
 
			 HeaderFooter class was available in itext.jar ,I tried using this class with PDFtemplate and Phrase i am trying to put the image on the header and footer ,however the image comes perfectly for the first page ,its not applicable for the second or continuous page, is it possible to have the images in header and footer?
 Regards,
 Venkateswaran
 
			 Questions about third-party APIs should be asked in the forum/newsgroup specific to that API. These forums are for questions relating to the API as provided by Sun.

Go find an iText forum.
 
		   

 
           	 
		     Need CS4 3 Column Liquid Head and Footer for CS5
 
			 My professor is using the CS4 version of 3 Column Liquid with Header and Footer and this template has changed in CS5.  I find it hard to follow his examples without the proper file.  He says to change background color of a sidebar, and half of my website changes color.  Is there a way I can get this template please?
 
			 This is from cs3, I suppose it is the same;

<!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.0 Transitional//EN" "http://www.w3.org/TR/xhtml1/DTD/xhtml1-transitional.dtd">

<html xmlns="http://www.w3.org/1999/xhtml">

<head>

<meta http-equiv="Content-Type" content="text/html; charset=utf-8" />

<title>Untitled Document</title>

<style type="text/css"> 

<!-- 

body  {

    font: 100% Verdana, Arial, Helvetica, sans-serif;

    background: #666666;

    margin: 0; /* it's good practice to zero the margin and padding of the body element to account for differing browser defaults */

    padding: 0;

    text-align: center; /* this centers the container in IE 5* browsers. The text is then set to the left aligned default in the #container selector */

    color: #000000;

/* Tips for Elastic layouts 

1. Since the elastic layouts overall sizing is based on the user's default fonts size, they are more unpredictable. Used correctly, they are also more accessible for those that need larger fonts size since the line length remains proportionate.

2. Sizing of divs in this layout are based on the 100% font size in the body element. If you decrease the text size overall by using a font-size: 80% on the body element or the #container, remember that the entire layout will downsize proportionately. You may want to increase the widths of the various divs to compensate for this.

3. If font sizing is changed in differing amounts on each div instead of on the overall design (ie: #sidebar1 is given a 70% font size and #mainContent is given an 85% font size), this will proportionately change each of the divs overall size. You may want to adjust based on your final font sizing.

.thrColEls #container { 

    width: 46em;  /* this width will create a container that will fit in an 800px browser window if text is left at browser default font sizes */

    background: #FFFFFF;

    margin: 0 auto; /* the auto margins (in conjunction with a width) center the page */

    border: 1px solid #000000;

    text-align: left; /* this overrides the text-align: center on the body element. */

/* Tips for sidebar1:

1. Be aware that if you set a font-size value on this div, the overall width of the div will be adjusted accordingly.

2. Since we are working in ems, it's best not to use padding on the sidebar itself. It will be added to the width for standards compliant browsers creating an unknown actual width. 

3. Space between the side of the div and the elements within it can be created by placing a left and right margin on those elements as seen in the ".thrColEls #sidebar1 p" rule.

.thrColEls #sidebar1 {

    float: left; 

    width: 11em; /* since this element is floated, a width must be given */

    background: #EBEBEB; /* the background color will be displayed for the length of the content in the column, but no further */

    padding: 15px 0; /* top and bottom padding create visual space within this div */

.thrColEls #sidebar2 {

    float: right; 

    width: 11em; /* since this element is floated, a width must be given */

    background: #EBEBEB; /* the background color will be displayed for the length of the content in the column, but no further */

    padding: 15px 0; /* top and bottom padding create visual space within this div */

.thrColEls #sidebar1 h3, .thrColEls #sidebar1 p, .thrColEls #sidebar2 p, .thrColEls #sidebar2 h3 {

    margin-left: 10px; /* the left and right margin should be given to every element that will be placed in the side columns */

    margin-right: 10px;

/* Tips for mainContent:

1. If you give this #mainContent div a font-size value different than the #sidebar1 div, the margins of the #mainContent div will be based on its font-size and the width of the #sidebar1 div will be based on its font-size. You may wish to adjust the values of these divs.

2. The space between the mainContent and sidebar1 is created with the left margin on the mainContent div.  No matter how much content the sidebar1 div contains, the column space will remain. You can remove this left margin if you want the #mainContent div's text to fill the #sidebar1 space when the content in #sidebar1 ends.

3. To avoid float drop, you may need to test to determine the approximate maximum image/element size since this layout is based on the user's font sizing combined with the values you set. However, if the user has their browser font size set lower than normal, less space will be available in the #mainContent div than you may see on testing.

4. In the Internet Explorer Conditional Comment below, the zoom property is used to give the mainContent "hasLayout." This avoids several IE-specific bugs that may occur.

.thrColEls #mainContent {

  margin: 0 12em 0 12em; /* the right margin can be given in ems or pixels. It creates the space down the right side of the page. */

/* Miscellaneous classes for reuse */

.fltrt { /* this class can be used to float an element right in your page. The floated element must precede the element it should be next to on the page. */

    float: right;

    margin-left: 8px;

.fltlft { /* this class can be used to float an element left in your page */

    float: left;

    margin-right: 8px;

.clearfloat { /* this class should be placed on a div or break element and should be the final element before the close of a container that should fully contain a float */

    clear:both;

    height:0;

    font-size: 1px;

    line-height: 0px;

--> 

</style><!--[if IE]>

<style type="text/css"> 

/* place css fixes for all versions of IE in this conditional comment */

.thrColEls #sidebar1, .thrColEls #sidebar2 { padding-top: 30px; }

.thrColEls #mainContent { zoom: 1; padding-top: 15px; }

/* the above proprietary zoom property gives IE the hasLayout it needs to avoid several bugs */

</style>

<![endif]--></head>

<body class="thrColEls">

<div id="container">

  <div id="sidebar1">

    <h3>sidebar1 Content</h3>

    <p>The background color on this div will only show for the length of the content. If you'd like a dividing line instead, place a border on the left side of the #mainContent div if the #mainContent div will always contain more content than the #sidebar1 div. </p>

    <p>Donec eu mi sed turpis feugiat feugiat. Integer turpis arcu, pellentesque  eget, cursus et, fermentum ut, sapien. </p>

  <!-- end #sidebar1 --></div>

  <div id="sidebar2">

    <h3>sidebar2 Content</h3>

    <p>The background color on this div will only show for the length of the content. If you'd like a dividing line instead, place a border on the right side of the #mainContent div if the #mainContent div will always contain more content than the #sidebar2 div. </p>

    <p>Donec eu mi sed turpis feugiat feugiat. Integer turpis arcu, pellentesque  eget, cursus et, fermentum ut, sapien. </p>

  <!-- end #sidebar2 --></div>

  <div id="mainContent">

    <h1> Main Content </h1>

    <p>Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Praesent aliquam,  justo convallis luctus rutrum, erat nulla fermentum diam, at nonummy quam  ante ac quam. Maecenas urna purus, fermentum id, molestie in, commodo  porttitor, felis. Nam blandit quam ut lacus. </p>

    <p>Quisque ornare risus quis  ligula. Phasellus tristique purus a augue condimentum adipiscing. Aenean  sagittis. Etiam leo pede, rhoncus venenatis, tristique in, vulputate at,  odio. Donec et ipsum et sapien vehicula nonummy. Suspendisse potenti. Fusce  varius urna id quam. Sed neque mi, varius eget, tincidunt nec, suscipit id,  libero. </p>

    <h2>H2 level heading </h2>

    <p>Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Praesent aliquam,  justo convallis luctus rutrum, erat nulla fermentum diam, at nonummy quam  ante ac quam. Maecenas urna purus, fermentum id, molestie in, commodo  porttitor, felis. Nam blandit quam ut lacus. Quisque ornare risus quis  ligula. Phasellus tristique purus a augue condimentum adipiscing. Aenean  sagittis. Etiam leo pede, rhoncus venenatis, tristique in, vulputate at, odio.</p>

    <!-- end #mainContent --></div>

    <!-- This clearing element should immediately follow the #mainContent div in order to force the #container div to contain all child floats --><br class="clearfloat" />

<!-- end #container --></div>

</body>

</html>
 
		   

 
           	 
		     Header and Footer for ALV Layout
 
			 Hi All,
 I have used the following code to create the Header and Footer Areas for ALV Report.
   CLEAR: FS_EVENTCAT.
   FS_EVENTCAT-NAME = 'TOP_OF_PAGE'.
   FS_EVENTCAT-FORM = 'build_comment'.
   APPEND FS_EVENTCAT TO GT_EVENTS.
   CLEAR: FS_EVENTCAT.
   FS_EVENTCAT-NAME = 'END_OF_LIST'.
   FS_EVENTCAT-FORM = 'F_WRITE_SUMMARY'.
   APPEND FS_EVENTCAT TO GT_EVENTS.
 Now the space is available for both Header and Footer...
 But i would like to display the Text in Header and Footer areas...
 How to insert the Texts....????
 Can you help me please.....???
 Regards
 Pavan
 
			 Hi,

Try with following example program:

REPORT  ZRJR02                                  .

*Table declaration.

TABLES:ZEMP_MST,ZDEPT_MST,ZDESG_MST,ZSL_TXN.

*Varriable declaration.

TYPE-POOLS SLIS.

DATA : POS TYPE I.

DATA  REPID  LIKE SY-REPID.

DATA : F1 TYPE SLIS_T_FIELDCAT_ALV,

       F2 TYPE SLIS_FIELDCAT_ALV,

       L_LAYOUT TYPE SLIS_LAYOUT_ALV.

DATA  L_POS TYPE I VALUE 1.               "position of the column

DATA  GT_FIELDCAT TYPE SLIS_T_FIELDCAT_ALV.

*DATA  GT_SORT TYPE SLIS_T_SORTINFO_ALV.

data:  GT_EVENTS    TYPE SLIS_T_EVENT,

       FS_EVENTCAT LIKE LINE OF GT_EVENTs.

*Internal table declaration.

*DATA  BEGIN OF IT_SORT OCCURS 5.

     INCLUDE TYPE SLIS_SORTINFO_ALV.

*DATA  END OF IT_SORT.

DATA:BEGIN OF ITAB OCCURS 0,

      ZEMPNO    LIKE ZEMP_MST-ZEMPNO,

      ZEMPNAME  LIKE ZEMP_MST-ZEMPNAME,

      ZDEPTCD   LIKE ZEMP_MST-ZDEPTCD,

      ZDEPTNAME LIKE ZDEPT_MST-ZDEPTNAME,

      ZDESGCD   LIKE ZEMP_MST-ZDESGCD,

      ZDESGNAME LIKE ZDESG_MST-ZDESGNAME,

     END OF ITAB.

REFRESH ITAB.CLEAR ITAB.

START-OF-SELECTION.

SELECT AZEMPNO AZEMPNAME AZDEPTCD BZDEPTNAME AZDESGCD CZDESGNAME

       FROM ZEMP_MST AS A

         INNER JOIN ZDEPT_MST AS B

           ON AZDEPTCD EQ BZDEPTCD

         INNER JOIN ZDESG_MST AS C

           ON AZDESGCD EQ CZDESGCD

       INTO CORRESPONDING FIELDS OF TABLE ITAB.

IF SY-SUBRC <> 0.

   MESSAGE E899(M3) WITH 'No records'.

ENDIF.

perform f_build_eventcat.

PERFORM LAYOUT.

END-OF-SELECTION.

*&      Form  LAYOUT

FORM LAYOUT .

  PERFORM FCAT USING 'ZEMPNO'    'ITAB' '' 'Emp.No.'   'ZEMPNO'    'ZEMP_MST'  ''.

  PERFORM FCAT USING 'ZEMPNAME'  'ITAB' '' 'Emp. Name' 'ZEMPNAME'  'ZEMP_MST'  ''.

  PERFORM FCAT USING 'ZDEPTCD'   'ITAB' '' 'Dept.Code' 'ZDEPTCD'   'ZEMP_MST'  ''.

  PERFORM FCAT USING 'ZDEPTNAME' 'ITAB' '' 'Dept.Name' 'ZDEPTNAME' 'ZDEPT_MST' ''.

  PERFORM FCAT USING 'ZDESGCD'   'ITAB' '' 'Desg.Code' 'ZDESGCD'   'ZEMP_MST'  ''.

  PERFORM FCAT USING 'ZDESGNAME' 'ITAB' '' 'Desg.Name' 'ZDESGNAME' 'ZDESG_MST' ''.

 PERFORM LSORT USING  'ZEMPNO' 'IDATA' ''.

 PERFORM LSORT USING  'ZEMPNAME' 'IDATA' ''.

 MOVE IT_SORT[] TO GT_SORT[].

  REPID = SY-REPID.

  CALL FUNCTION 'REUSE_ALV_LIST_DISPLAY'

    EXPORTING

         I_CALLBACK_PROGRAM       = REPID

         IT_FIELDCAT              = F1

        IT_SORT                  = GT_SORT

         I_SAVE                   = 'X'

         IT_EVENTS                = GT_EVENTS[]

     TABLES

          T_OUTTAB                 = ITAB.

  IF SY-SUBRC <> 0.

    MESSAGE ID SY-MSGID TYPE SY-MSGTY NUMBER SY-MSGNO

          WITH SY-MSGV1 SY-MSGV2 SY-MSGV3 SY-MSGV4.

  ENDIF.

ENDFORM.                    " LAYOUT

*&      Form  FCAT

FORM FCAT USING P_FIELD P_TABLE P_SUM P_TEXT P_RFIELD P_RTABLE P_DISP.

  ADD 1 TO POS.

  F2-COL_POS       = POS.

  F2-FIELDNAME     = P_FIELD.

  F2-TABNAME       = P_TABLE.

  F2-SELTEXT_L     = P_TEXT.

  F2-REF_FIELDNAME = P_RFIELD.

  F2-REF_TABNAME   = P_RTABLE.

  F2-DO_SUM        = P_SUM.

  F2-NO_OUT        = P_DISP.

  APPEND F2 TO F1.

  CLEAR F2.

ENDFORM.                " FCAT

*&      Form  LSORT

*FORM LSORT USING P_FIELD P_TABLE P_UP.

 ADD 1 TO L_POS.

 IT_SORT-SPOS      = L_POS.

 IT_SORT-FIELDNAME = P_FIELD.

 IT_SORT-TABNAME   = P_TABLE.

 IT_SORT-UP        = P_UP.

 APPEND IT_SORT.

*ENDFORM.                    " LSORT

FORM F_BUILD_EVENTCAT .

 CLEAR: GT_EVENTS.  REFRESH: GT_EVENTS.

  CLEAR: FS_EVENTCAT.

  FS_EVENTCAT-NAME = 'TOP_OF_PAGE'.

  FS_EVENTCAT-FORM = 'F_REPORT_HEADER_ALV'.

  APPEND FS_EVENTCAT TO GT_EVENTS.

  CLEAR: FS_EVENTCAT.

  FS_EVENTCAT-NAME = 'END_OF_LIST'.

  FS_EVENTCAT-FORM = 'F_WRITE_SUMMARY'.

  APPEND FS_EVENTCAT TO GT_EVENTS.

ENDFORM.                    " F_BUILD_EVENTCAT

FORM F_REPORT_HEADER_ALV.

CALL FUNCTION 'Z_YHEAD_PRINT'

 EXPORTING

   TITLE1        = 'XYZ Limited'

   TITLE2        = 'Employee Master'

   TITLE3        = 'Created on '

   COLOR         = 'X'

ENDFORM.

*&      Form  F_WRITE_SUMMARY

      Write summary before exit

FORM F_WRITE_SUMMARY .

write:/ 'Welcome to XYZ Limited'.

write:/ 'This is a test program to display Report in ALV Format'.

ENDFORM.

Regards,

Bhaskar
 
		   

 
           	 
		     How can I remove the header and footer for more space in my Pages docs?
 
			 I could really use the extra space on my docs. How can I get rid of the header and footer?
 Thanks
 
			 Hi Timothy

Just to detail exactly where to find the options:

+Inspector > Document > Document > Document Margins > Headers/Footers+

+commnd option i+ shows and hides your Inspector palette/s.

Peter
 
		   

 
           	 
		     Getting error while generating Business Blueprint Document for Project
 
			 Hello Experts,
 I hv created a project in Solution manager 3.2 through solar_project_admin . Now iam in the phase of defining its Business Blueprint . I hv completed the steps, at the end when iam generating Business Blueprint document ,following error is being displayed:
 <b>Blueprint document cannot be created. Check the selection
 Message no. SOLAR110
 Diagnosis
 A Business Blueprint document created for the selected selection options would contain no structure elements. It would be empty, so it is not created.
 Procedure
 Choose less restrictive selection options, especially the option
 "Print Structure Elements: Complete Selection" in the "Options" tab.</b>
 I hv checked this error and the option displayed above in the error message but no such option is being displayed anywhere,can anyone plz help me out with how to resolve this problem?
 Requested to revert at earliest as iam stuck with this since many days,My email id is <b>[email protected]</b> .
 Regards,
 Saumya
 
			 Hello Horst ,

Thanks for ur reply.I hv now again tried to Generate Blueprint Document with unselecting option Only with Documents but in the structure selection when i tick on all the options given in tat structure then regenerate Business blueprint Document ,following error message is displayed:

<b>Error 130: Business Blueprint cannot be generated

Message no. AI_SOLAR08130</b>

For this error no long text/ explaination exists .But when i try to generate Business Blueprint Document with unselecting option Only with Documents but in the structure selection unticking on all the options given in tat structure then following error message is displayed:

<b>Blueprint document cannot be created. Check the selection

Message no. SOLAR110

Diagnosis

A Business Blueprint document created for the selected selection options would contain no structure elements. It would be empty, so it is not created.

Procedure

Choose less restrictive selection options, especially the option

"Print Structure Elements: Complete Selection" in the "Options" tab.</b>

Plz revert back, wt shld i do now?

Regards,

Saumya
 
		   

 
           	 
		     Dynamic header and footer for ALV_LIST
 
			 Hi all,
 I m using FM REUSE_ALV_LIST_DISPLAY to display my report.
 My requirements are as follows:
 1. Display the header for every new key/sorted value
 2. Display the footer at the end of the key/sorted value
 3. Display a subtotal for numeric columns based on each key value
 4. Page break at the change to a new key/sorted value
    (based on sample data below, the key/sorted value is the Vendor code)
 Appreciate if anyone can provide any sample codes to meet the above requirements.
 Internal table Data:
 Vendor     Date          Amount
 1001     10.04.2009       1000
 1001     11.04.2009       1500
 2001     08.04.2009        800
 2001     13.04.2009       1200
 2001     15.04.2009       1000
 3001     01.04.2009        500
 3001     02.04.2009        700
 ALV List output:
 Header: Vendor: 1001
 Vendor     Date          Amount
 1001     10.04.2009       1000
 1001     11.04.2009       1500
 Subtotal                                    2500
 Footer:
 This is end of list for vendor 1001
   Page break
 Header: Vendor: 2001
 Vendor     Date          Amount
 2001     08.04.2009        800
 2001     13.04.2009       1200
 2001     15.04.2009       1000
 Subtotal                                    3000
 Footer:
 This is end of list for vendor 2001
     Page break
 Header: Vendor: 3001
 Vendor     Date          Amount
 3001     01.04.2009        500
 3001     02.04.2009        700
 Subtotal                                    1200
 Footer:
 This is end of list for vendor 3001
 
			 Hi Pang,

Have a look at the sample program. develop your program accordingly. It helps you a lot.

REPORT ztest_upload_from_u_n_l.

TYPE-POOLS: slis.

*---internal tables

DATA: BEGIN OF it_flight OCCURS 0,

       carrid  LIKE sflight-carrid,

       connid   LIKE sflight-connid,

       fldate   LIKE sflight-fldate,

       seatsmax LIKE sflight-seatsmax,

       seatsocc LIKE sflight-seatsocc,

      END OF it_flight,

*--internal tables for alv

      it_fieldcat TYPE  slis_t_fieldcat_alv,

      wa_fcat LIKE LINE OF it_fieldcat,

      layout TYPE  slis_layout_alv,

      it_sort TYPE  slis_t_sortinfo_alv,

      wa_sort LIKE LINE OF it_sort.

*---start-of-selection .

START-OF-SELECTION.

  CALL FUNCTION 'REUSE_ALV_FIELDCATALOG_MERGE'

       EXPORTING

            i_program_name         = 'ZTEST_UPLOAD_FROM_U_N_L'

            i_internal_tabname     = 'IT_FLIGHT'

            i_inclname             = 'ZTEST_UPLOAD_FROM_U_N_L'

       CHANGING

            ct_fieldcat            = it_fieldcat

       EXCEPTIONS

            inconsistent_interface = 1

            program_error          = 2.

*----get data

  SELECT carrid

         connid

         fldate

         seatsmax

         seatsocc

   FROM sflight

   INTO CORRESPONDING FIELDS OF TABLE it_flight

   UP TO 20 ROWS.

  wa_fcat-do_sum = 'X'.

  MODIFY it_fieldcat FROM wa_fcat TRANSPORTING do_sum

   WHERE fieldname = 'SEATSOCC'.

  wa_sort-fieldname = 'CARRID'.

  wa_sort-group = '*'.

  wa_sort-up = 'X'.

  APPEND wa_sort TO it_sort.

  wa_sort-fieldname = 'CONNID'.

  wa_sort-subtot = 'X'.

  wa_sort-up = 'X'.

  APPEND wa_sort TO it_sort.

  CALL FUNCTION 'REUSE_ALV_LIST_DISPLAY'

       EXPORTING

            i_callback_program = 'ZTEST_UPLOAD_FROM_U_N_L'

            is_layout          = layout

            it_fieldcat        = it_fieldcat

            it_sort            = it_sort

       TABLES

            t_outtab           = it_flight

       EXCEPTIONS

            program_error      = 1.

Thanks

Venkat
 
		   

 
           	 
		     Error while modifying icon and name in the subpalette
 
			 Hi.... I have made three subVIs and want to distribute as LabVIEW library.
 I made a llb file and added all three sbVIs in that. And put it in user.lib. In all three dll there are Call Library Function means I have one dll. I have put this DLL in the use.lib folder. 
 Problem:
 The icon and name of my application in the LabVIEW "User Libraries" pallete are default. I want it to set automatically set to my desire icon for that subpallete and desire name as well. How can I do that?
 I am using LabVIEW 6i. I tried to change the icon and name. And I tried according to following link and in the third step it says
 "Right-click an icon in the custom view and remove the checkmark next to Synchronize with Directory in the shortcut menu."
 But that option is greyed out, how can I remove checkmark against that.
 http://digital.ni.com/public.nsf/3efedde43...enDocument#rank
 I also tried to rename readonly.txt file in default folder in menu folder. I tried to add in default folder but it does not sucess. It is always giving error that please check the read only attribute.
 One Dll is used in all three subVIs. When I set relative path ".\MY_DLL.dll" in the configuration of Call Library Function then it is chaging it to absolute path automatically.
 I want it relative so that when user put my_llb.llb file and my_dll.dll file into user.lib folder then it will automatically take that dll instead of searching for that DLL in the nearest location. What should I do?
 Do I require to buy Application Builder for that-specially for setting my own icon & name for "subPallete" of my library. 
 Thanks in advance......
 
			 Hi,

Here are step-by-step instructions on how

to insert a custom sub-palette in the Instrument Drivers or User

Libraries palettes in LabVIEW 6.0 and above. 

 Save one of the VIs required for the instrument driver as a library (*.llb):

 Select File»Save or Save As to display the Name the VI dialog box. 

 Click the New VI Library button to display the New VI Library dialog box. 

Enter the name of the new library and click the VI Library button.

LabVIEW automatically adds a .llb extension to the name of the library.

 The Name the VI dialog box reappears. Enter the name of your VI to save it in the new library.

 Close LabVIEW.

Browse to the directory where LabVIEW is installed and open the

"instr.lib" folder to insert a new menu into the Instrument Drivers

palette (or the user.lib for the User Libraries palette). Create a new

folder and name it appropriately. Copy the .llb file into that new

folder.

 Open LabVIEW and open a new VI. Pin down the

palette by right clicking and clicking on the push-pin on the upper

left hand corner so that the palette is fixed on the screen. Then click

on the Options button on the toolbar at the top.

 Select

the "Edit Palettes..." button. Navigate to the Instrument Drivers

palette and right click on the icon with the name of the folder that

you created. Select "Delete Submenu".

 Right click on an open area on the palette and select Insert»Submenu.

When prompted, select "Create a new menu file (.mnu)". Save this in the

folder that you created in step __. (Remember to type the .mnu file

extension on your file name) Typically this mnu file is named dir.mnu.

When prompted, enter the name for the submenu, and select ok.

 Open the new submenu.  Now you can insert VIs (by right clicking in the empty space and going to Insert»VI

and selecting it from the .llb file) or additional submenus as you

desire. When creating new submenus, it is recommended to create a new

.mnu file for each submenu and save it in the folder you created.

 Next you can edit the icons for the submenus by right clicking and selecting Edit Submenu Icon.

 When you are finished, select "Save Changes" from the "Edit Controls and Palettes" dialog box.

To port the new menu in the Instrument Drivers palette onto another

computer with LabVIEW, just copy the folder (and its contents) that you

created and paste it into the instr.lib folder. When LabVIEW is loaded

it will see the new folder and load the menus.

Note:

If you save the changes and return to add more submenus you may receive

an error instructing you to check the read-only properties. To fix

this, begin the editing process. Then right click on the menu that you

created in the Instrument Drivers palette and select "Synchronize with

Directory" so that the check mark beside it disappears. This will allow

you to save your changes. For more information on this see the related

link below.

I hope this helps,

Regards,

Nadim 

Applications Engineering

National Instruments
 
		   

 
         
 
        
 
		 
          Maybe you are looking for
 
          	 
		     Create report output to the Client of the Application Server inst.of Server
 
			 Hi, Please suggest the soution for the below: We are using SET_REPORT_OBJECT_PROPERTY and WEB.SHOW_DOCUMENT to create report. Now Requirement is to save the report output to Client instead of server. I tried to use WEBUTIL but web util can be used fr
 
		   
	 
		     How to refresh MessageChoice in advanced table on LOV change?
 
			 I have an advanced table for data entry. One column has Employee Name, which is an LOV. Another column is a MessageChoice, listing eligible elements for that person. Everything works fine when the page is first loaded. This is the code I'm using in p
 
		   
	 
		     Service data location on mac os x lion server 10.7.4
 
			 here's my problem..... in mac os x lion server, sever app, under hardware/settings, one can change the service data location (in my case from the server HD to an external HD), which I was trying to do. After the first attempt, I got an error message,
 
		   
	 
		     Outlook Synchronization with BB does not include e-mail. Is there a solution ?
 
			 I have downloaded the latest version of the BB Desktop software and I have no problem with synchronization of my contacts, calendar, reminders and notes. However, there is no option (tick box) to select synchronization of my BB email with my desktop 
 
		   
	 
		     Partition Exchange Swapping the data instead of Increment
 
			 can somebody help me with the below scenerio: I have two tables stg_dim and final_dim table. It is working for first time loading but when i load second time into same partition swapping the data between two tables. For example : first time i loaded 
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